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ABSTRACT

Cinchona officinalis, known locally as cascarilla or cinchona, is a plant species native to South
America. It was used as a source of quinine to combat malaria in the 17th century. The spe-
cies is threatened by various anthropogenic activities. Further, the propagation of the spe-
cies depends on seed dispersal and its germination capacity. Therefore, it is necessary to
conserve and propagate this species. Because C. officinalis seeds have a low germination
capacity, we determined the effect of arbuscular mycorrhizae (AM) on their germination and
growth. A randomized design was employed with two treatments, one treated with mycor-
rhizae (CM) and another without mycorrhizae (SM). For each treatment, three replicates of
100 seeds were used. Germination, growth, and fungal characteristics were evaluated. In ger-
mination parameters, the CM treatment showed better performance, but the improvement
was statistically insignificant. However, the ag)plicatinn of AM significantly improved seedling
height (cm), root length (cm), leaf area (cm”), and root number by 53.52, 28.72, 29.73, and
61.66%, respectively. Likewise, mycorrhization intensity (%), mycorrhization frequency (%),
and extraradical mycelium length (cm) in the CM treatment were 37.13, 3.44, and 174.97%
higher compared to the SM treatment, respectively. Therefore, the use of AM fungi proves
to be advantageous in the propagation of C. officinalis, and these results provide a basis for
the largescale and sustainable propagation of this species.
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Introduction 2021). The survival of C. officinalis in natural environ-
ments depends on seed dispersal; however, the species
has a low germination capacity (De-la-Cruz et al. 2007;
Valdiviezo et al. 2018), which is affected by factors,
such as seed quality, humidity, temperature, and
microbial activity (Santos et al. 2010).

Arbuscular mycorrhizae (AM) are a group of obli-
gate symbionts involved in diverse ecological processes
(van der Heijden et al. 2015). AM are symbiotically
related to more than 85% of terrestrial plants
(Brundrett and Tedersoo 2018; Dey and Ghosh 2022).

This relationship provides diverse benefits to the host

Peru is home to diverse cultures, ecosystems, and flora
and fauna (Fajardo et al. 2014), including very import-
ant medicinal and food plants (De-la-Cruz et al. 2007).
Cinchona is a genus of medicinally valuable plants,
such as Cinchona officinalis, Cinchona pubescens, and
Cinchona calisaya, the barks of which contain alka-
loids, such as quinine, which provided the only treat-
ment against malaria for over 300 years (Condor et al.
2009; Canales et al. 2020).

Several studies have reported that C. officinalis
needs specific conditions to grow and its distribution

ranges are limited (Armijos-Gonzadlez and Pérez-Ruiz
2016). In Peru C. officinalis is found in small pockets
of Andean forest, particularly in the Cajamarca and
Piura regions (Huamdn et al. 2019). This species is
threatened by urbanization, migratory agriculture, cat-
tle ranching, and widespread selective logging (Arbizu
et al. 2021), which has led to the prioritization of its
conservation and recovery in Peru (Alban-Castillo
et al. 2020). The restoration and preservation of this
iconic species require the generation of knowledge
related to its propagation (Sanchez-Santillan et al

plant; for example, it helps mitigate environmental
stress (Hosseyni Moghaddam et al. 2021), enhances the
uptake of P (Griimberg et al. 2015) and other less
mobile nutrients (Lehmann and Rillig 2015; Garg and
Singh 2018), facilitates low hydraulic gradient water
uptake (Augé et al. 2015), provides protection from
pathogen attack, slows nitrification and nitrogen leach-
ing, and accelerates organic matter degradation
(Veresoglou and Rillig 2012; Leitheit et al. 2014;
Powell and Rillig 2018; Veresoglou et al. 2019). In add-

ition, AM provides nutrients that are of great
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importance for seed germination and subsequent plant
establishment (Dearnaley 2007). At the laboratory
level, AM has been reported to positively affect seed
germination in forest species (Ballina et al. 2017).
Under natural conditions, AM hyphal networks may
positively affect both germination and seedling estab-
lishment (Varga 2015).

In the present study, we sought to determine
whether AM affects the germination and initial growth
of C. officinalis as there is little information on the use
of these biofertilizers in the propagation of this
important medicinal species. In the future, AM could
be used as a biofertilizer to accelerate the growth of C.
officinalis. Furthermore, the results of this study could
be used to implement recovery plans and programs for
this species.

Materials and methods
Study area

The study was conducted from 20 November 2021 to
20 April 2022 in the La Cascarilla community (5° 40’
21.12" S and 78° 53’ 55.65" W), district of Jaen, Peru,
at 1810 m asl. The annual precipitation is 1730 mm,
and the mean annual minimum and maximum tem-
peratures are 13.0 and 20.5°C, respectively (Fernandez
et al. 2021; Fernandez and Huaccha 2022).

Plant material

We used the seeds of C. officinalis that were collected
in October 2021 from a tree in the San Luis commu-
nity, Cajamarca region, Peru (6° 22’ 6.68" S and 79° 3’
29.50" W) at 2489 m asl. We collected 0.5 kg of mature
capsules (brown to dark brown color) in cloth bags
and carried them to the La Cascarilla community,
located 100 km from the collection site, and the capsu-
les were stored under shade. Twenty days later, seeds
without visible cracks, fungi, and/or nematodes were
selected and used for the study. Storage of seeds was
avoided as the seeds of C. officinalis are recalcitrant,
which makes them lose their germination capacity very
quickly (Caraguay et al. 2016).

E-IS5N 2158-0715

Microbiological inoculation

We used M}'anmw‘E-Cnmplex (Grow More, Gardena,
CA, USA), which contains the AM Glomus intraradi-
ces, Glomus mosseae, and Glomus aggregatum as inocu-
lum. The product data sheet recommended using 6 kg
of MycoGrow for each cubic meter of the substrate.
Thus, considering that the volume of the experimental
units was 7260cm’, we incorporated 43.56g of
MycoGrow into the substrate of each unit before sow-
ing the seeds.

Substrate

The substrate used for the germination of C. officinalis
consisted of 100% sand, which was sterilized in an
autoclave at 105°C for 1h; this process was repeated
for 3 consecutive days. The physicochemical character-
istics of the substrate were: sandy texture; pH, 7.7;
electrical conductivity (dS m™!), 457.33; organic
matter, 1.82%; total nitrogen, 0.8%; and phos-
phorus, 3.21 ppm.

Experimental design and set-up

A randomized design with two treatments and three
replicates per treatment was used; 100 seeds of C. offi-
cinalis were used for each replicate, and 600 seeds
were used for the whole trial.

A sub-irrigation chamber as described by Fernandez
et al. (2021) was used in the study. The substrate con-
taining mycorrhizae (CM) was introduced to three

experimental units, and the substrate without mycor-
rhizae (SM) was introduced to another three experi-
mental units (Figure 1). The substrate was moistened
to field capacity, which was confirmed by touch. The
seed viability was determined by the flotation test,
wherein the seeds that remained floating on the water
were discarded. The entire sub-irrigation chamber was
manually irrigated every day with 50 mL of water. The
sub-irrigation chamber was covered with Raschel mesh
of 85% shade to reduce the direct incidence of
solar radiation.

CM1 SMI1 SM2

SM3 CM2 CM3

Figure 1. Sub-irrigation chamber and randomized design were used in the trial.
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Data collection and evaluation

Germination parameters
Germination percentage was calculated using the fol-
lowing equation:

Germination (%) = Number of seeds that germinated

Number ﬂf seeds sown

x 100

Germination rate coefficient (RC) was calculated
using the following equation:

n;
RC = 2
. (nit:)
Average germination time (T) was calculated using
the following equation:

x 100

1'= L::w.: 100
RC

Germination speed (GS) was calculated using the
following equation:

o 23

where n; is the number of seeds that managed to ger-
minate per day i, f; is the number of days after sowing,
and t is the germination time from sowing to the ger-
mination of the last seed.

We also calculated several germination parameters,
such as germination energy (GE), energy period (EP),
germination capacity (GC), and maximum germination
value (MGV) according to Czabator (1962) and
Gonzailez et al. (2008). GE is the daily cumulative ger-
mination percentage, obtained when germination
reaches its maximum; EP is the number of days
required to achieve the maximum germination; GC is
the percentage of seeds that germinated during the
study, along with the healthy seeds that failed to ger-
minate; MGV is the final mean germination, which
was calculated by dividing the cumulative germination
percentage at the end of the trial by the number of
days of the trial; and MV is the maximum daily aver-
age germination recorded during the trial.

Growth parameters

Root length, seedling height, leaf area, and the number
of roots per seedling were measured 120 days (or on the
120th day) after sowing C. officinalis seeds to evaluate
the potential influence of AM on the initial growth of
seedlings. The seedlings were photographed against a
white background (20 x 12c¢m cardboard) with a 2cm
reference line drawn next to the leaves for scale in
image processing. To extend the leaves, they were cov-
ered with 20 x 12 x 0.3 cm transparent glass. The photo-
graphs were taken using a smartphone (Huawei P30
Lite, 24-megapixel MAR-LX3A camera). The images
were then processed using Image] software, according to
the following processes: (1) File > Open > Image > Line
Width > Analyze > Set Scale > Line Width (to measure
the stem and root length); and (2) File > Open > Line

FOREST SCIENCE AND TECHNOLOGY @ 3

Width > Analyze > Set Scale > Polygon Selections >
Analyze > Measure (Baker et al. 1996).

Fungal characteristics
To determine mycorrhizal colonization (MC), a root
staining process was performed according to the meth-
ods of Phillips and Hayman (1970) with minor modifi-
cations; the roots were treated with vinegar and
hydrogen peroxide, subjected to a water bath, and
stained with trypan blue. After staining, they were cut
into thirty fragments of 1cm sections. Each fragment
was placed on a slide and then observed under a
microscope at 100x objective magnification.

The percentage of internal hyphal colonization, or
mycorrhizal frequency (MF), was determined using the
formula of Sieverding et al. (1991) given below:

Number of roots colonized
MF = x 100
Number of roots observed

The mycorrhizal intensity (IM) was determined using
the formula of Trouvelot et al. (1986) given below.

(n1 +5 x n2+ 30 x n3 4+ 70 x nd 4+ 95 x n5)
N

IM =

where N is the total number of roots that were eval-
uated, and n is the number of classified fragments.

To estimate the length of extraradical mycelium
(LMER), one gram of soil was weighed and stained accord-
ing to the methods of Carballar (2010) with some modifi-
cations. The stained soil was placed in Petri dishes with
0.5cm® quadrats at the base. The hyphae were observed at
the line intersections under a stereoscope at 3x and 4.5x
magnification (Carballar 2010). The LMER was calculated
using the equation given by Newman (1966).

B mTAN
- 2H

R

where

R is mycelium length per unit soil; A is area of the
plate, N is the number of intersections, and H is the
total length of the lines of the plate (cm).

Data analysis

An independent sample f-test was used to compare the
means of the replicates of each treatment (p=0.05)
after confirmation of the normality of data using the
Shapiro-Wilk test. All statistical analyses were per-

formed using StatGraphics Centurion XVI (StatPoint
Technologies Inc., Warrenton, VA, USA).

Results

In both treatment groups, C. officinalis seed germin-
ation was characterized by a sigmoid curve and the
highest percentage of germination between days 19
and 31 (Figure 2(A)). Notably, the germination curve
of the CM treatment group was slightly above that of
the SM treatment group. Although a higher cumulative
germination percentage was observed in the CM treat-
ment, there were no significant differences between the
two groups (Figure 2(B)). Figure 3 and Table 1 shows
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Figure 2. (A) Cumulative germination percentage of C officinalis in substrate containing mycorrhiza (CM) and without mycarrhiza (SM). (B) Percentage
germination of C officinalis reached at the end of the trial in each treatment. Bars with the same lowercase letters indicate no significant differen-

ces (p > 0.05).
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Figure 3. (A) Average daily germination, (B) germination speed, (C) germination energy, (D) energy period, (E) germination capacity, and (F) maximum
germination value of C. officinalis seeds obtained in the two study treatments. Bars with the same lowercase letters indicate no significant differen-

ces (p > 0.05).

Table 1. Germination parameters evaluated in C. officinalis.

Germination parameters M SM

Average germination time (days) 24.41 +0.88 24.39+0.96
Germination speed (seeds/day) 0.76+0.10 0.68+0.11
Germination energy (%) 15.67 £4.51 1067 +3.79
Energy period (days) 20.33 +£2.31 19+0.00
Germination capacity (%) 36+ 458 3467 +5.51
Maximum germination (germinated seeds/day) 8.15+293 6.71+339
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Figure 4. Growth parameters were evaluated 120days after sowing C officinalis seeds. (A) average seedling height, (B) average root length of seed-
lings, (C) estimated leaf area, and (D) average number of roots per seedling of C officinalis. Different lowercase letters indicate significant differen-

ces (p < 0.05).

Table 2. Growth parameters were measured 120 days after sowing
seeds of C. officinalis.

Growth parameters M SM

Average seedling height (cm) 1.09+0.05 0.71 +0.02
Average root length of seedlings (cm) 1.21+0.13 0.94 +0.06
Estimated leaf area (cm?) 0.96 +0.07 0.74+0.05
Average number of roots 7.00+1.00 433+0.58

the results of the germination parameters evaluated in
the study. The CM treatment enhanced the perform-
ance of all evaluated parameters; however, no signifi-
cant differences were found between the treatments.

The analysis of growth parameters after 120 days of
sowing the C. officinalis seeds showed that plant height
in the CM treatment was 53.7% higher than that in
the SM treatment (Figure 4(A)). The root length was
29.1% higher in the CM treatment than that in the SM
treatment (Figure 4(B)). The leaf area in the CM treat-
ment was 28.7% higher than that in the SM treatment
(Figure 4(C)). The number of roots in the CM treat-
ment was 28.7% higher than that of the SM treatment
(Figure 4(D)). For all the growth parameters evaluated,
significant differences were observed between CM and
SM treatments, demonstrating that AM positively
influenced the initial growth of seedlings during ger-
mination (Table 2).

Mycorrhizal frequency was significantly higher
(33.8%) in the CM treatment than in the SM treatment
(24.7%) (Figure 5(A)). The mycorrhizal intensity was
100 and 96.7% in the CM and SM treatment groups,
respectively, and although the CM treatment group

showed a higher frequency, it was insignificant
(Figure 5(B)). The length of the extraradical mycelium

was significantly higher in the CM treatment
(1157cm) than in the SM treatment (42.1 cm)
(Table 3).

Discussion

In tree species, there are studies that show the positive
effects of AM on cumulative germination due to the
protective-coating action of AM on seeds, preventing
infection by pathogens (Dalling et al. 2011; Huante
et al. 2012; Ballina et al. 2017). The same effects occur
in various species of orchids that depend on mycorrhi-
zae to supply them with nutrients and water owing to
the absence of endosperm in their seeds (Smith and
Read 2008; Yuan et al. 2016; Huang et al. 2018; Shao
et al. 2020; Figura et al. 2021). However, there are
reports that AM can also suppress germination owing
to the exudates they release (Louarn et al. 2012; Wu
et al. 2014; Varga 2015; Maighal et al. 2016; Ballina
et al. 2017). In this study, better germination param-
eter results were observed when AM fungi were inocu-
lated. However, these results were not significant,
presumably because of two factors (1) the high mycor-
rhizal specificity of some plant species (Zi et al. 2014;
Duran-Lopez et al. 2019; Meng et al. 2019; Fuji et al.
2020; Shao et al. 2020); or (2) that C. officinalis is not
AM-dependent to initiate or increase its germination.
Therefore, propose that future research should identify
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Figure 5. Mycorrhizal parameters were evaluated in the study. (A) percentage of mycorrhizal colonization, (B) frequency of mycarrhizal colonization,
and (C) length of extraradical mycelium. Bars with different lowercase letters indicate significant differences (p < 0.05).

Table 3. Fungal characteristics were determined in the root system of
C. officinalis seedlings at the end of the trial.

Fungal characteristics M SM

Mycorrhizal intensity (%) 3383+£290 2467+3.30
Mycorrhizal frequency (%) 100.00+0.00 9667 +5.77
Length of extraradicular mycelium (cm) 11568+65.70 42.07+18.22

AM species specific to C. officinalis, or confirm the

results obtained in this study.
However, the AM in this study showed a significant

positive influence on the initial growth of C. officinalis.
This may be attributed to the colonization of the seed
radicle by mycorrhizal hyphae, which provide protec-
tion and nutrition to seedlings and accelerate their
growth (Pankaj et al. 2021). In addition, AM signifi-
cantly improved the length and number of roots in
C. officinalis seedlings as observed in different studies
(Dovana et al. 2015; Khalediyan et al. 2021; Hagh-
Doust et al. 2022). Some authors claim that mycorrhi-
zae can increase root growth by up to 200% (Falcon
et al. 2021). This further improves plant growth
through increased access to soil nutrients (Weisany
et al. 2015; Weisany et al. 2016; Khalediyan et al
2021), as AM can increase nutrient uptake by 7-250

times depending on the crop (Naranjo et al. 2011).
Finally, the positive effects of AM on leaf area are

attributed to the percentage of AM colonization on
seedling roots (Yadav and Aggarwal 2015; Palacios
et al. 2021) and the LMER which was higher in the
mycorrhizal treatment. Colonization of AM can lead to
increased water and nutrient uptake by increasing the

surface area of uptake through the mycelium into the
soil, allowing the plant to have access to more soil; this
can lead to enhanced photosynthesis, improved plant

growth, and thus an increase in leaf area (Smith et al
2003; Huang et al. 2018; Khalediyan et al. 2021).

Conclusion

The results of this study suggest that AM are beneficial
biofertilizers for the propagation of C. officinalis as
they significantly improve seedling growth; therefore,
AM could be used for the sustainable mass propaga-
tion of this important plant species. In addition, the
results showed that G. intraradices, G. mosseae, and
G. aggregatum can have different effects on the ger-
mination process (neutral effect) and growth (positive
effect) of C. officinalis. Because our study did not
evaluate the effects of a specific mycorrhiza on germin-
ation or growth, it was not possible to determine the
individual effects of the mycorrhizal species under
study. Thus, we suggest further research is necessary to
determine whether C. officinalis has a tendency to
associate with particular or diverse mycorrhizal species.
From there, it may be possible to identify a mycorrhiza
that promotes the germination of C. officinalis. In add-
ition, it would be interesting to evaluate the effects of
AM for a period longer than 120 days, to analyze the
persistence or cessation of the effects observed in
this study.
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